Contents

Introduction 3
Contact Us 3
Gallery 4
    Creating a New Painting 5
    Deleting a Painting 5
    Sharing and Exporting 5
    Viewing Thumbnails 7
Painting 8
    Zooming and Panning 9
    Undo and Redo 10
    Paint Color 11
    Brush Settings 13
    Erasing 14
    Simulated Pressure 15
    Eyedropper 16
    Blending 17
    Shortcuts 19
    Duplicating a Painting 19
    Painting Properties 19
Layers 21
    Working with Layers 22
    Transforming Layers 23
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blending Modes</td>
<td>24</td>
</tr>
<tr>
<td>Placing a Photo</td>
<td>25</td>
</tr>
<tr>
<td>App Settings</td>
<td>27</td>
</tr>
<tr>
<td>External Displays (TV and VGA)</td>
<td>28</td>
</tr>
<tr>
<td>Brushes Viewer</td>
<td>29</td>
</tr>
<tr>
<td>Opening .brushes Files</td>
<td>29</td>
</tr>
<tr>
<td>Replaying the Painting</td>
<td>30</td>
</tr>
<tr>
<td>Rotating</td>
<td>30</td>
</tr>
<tr>
<td>Exporting an Image</td>
<td>31</td>
</tr>
<tr>
<td>Exporting a Movie</td>
<td>32</td>
</tr>
</tbody>
</table>
Introduction

Brushes is a digital finger painting application originally created from scratch for the iPhone, but redesigned to take full advantage of the iPad’s larger screen. Featuring a simple yet deep interface, high-quality brushes, multiple layers, and extreme zooming, it is a powerful tool for creating original artwork, anyplace and anytime.

Unlike other apps, Brushes records every brush stroke and erasure as you paint. Afterwards, you can use Brushes Viewer, a free application for Mac OS X, to replay your painting stroke by stroke. You can also export the painting at very high resolutions (up to 4608 x 6144), or export the replay as a QuickTime movie.

This guide explains how to use Brushes and Brushes Viewer.

Contact Us

Have a question about Brushes that was not covered in this guide? Please email us:

support@taptrix.com

For up to date information about Brushes, and the latest version of this guide, please visit the Brushes homepage:

http://brushesapp.com

Check out art from other Brushes artists, and contribute your own! Join the Flickr group “Brushes Gallery – iPhone/iPad Art”:

http://flickr.com/groups/brushes
Gallery

The Gallery is the first thing that you see when you open Brushes. The Gallery displays your paintings and allows you to navigate between them. The first time you open Brushes, a new blank painting is automatically created.

To switch between different paintings in the Gallery, swipe your finger.

To edit a painting, tap on it and it will expand to fill the screen. See the Painting section for more details on painting.

There are a number of actions that you can perform using the buttons at the bottom right of the screen:
Creating a New Painting

To create a new painting, tap the + button. A new blank painting will be created. The new painting will expand to fill the screen, allowing you to start editing it immediately.

Replaying a Painting

Brushes records every action that you perform while painting. By pressing the play button in the Gallery, you can see an exact replay of these actions. To stop the replay, tap the play button again (it will change to a square stop icon while the painting is playing) or tap on the painting itself.

Deleting a Painting

To delete a painting, tap the trash button in the Gallery. Brushes will ask if you’re sure before deleting the painting.

WARNING: Once deleted, a painting cannot be recovered.

Sharing and Exporting

Brushes provides a number of ways to share or export your painting. To access them, tap the sharing button:
Add to Photos

To add your painting to your iPad’s photo album tap Add to Photos.

The next time you launch the built-in Photos app, the painting will appear in your album. It will also get sent to your computer when you sync with iTunes or iPhoto. From the Photos app, you can assign it to a contact, set it as your wallpaper, and more.

NOTE: When added to your photo album, paintings are saved in the JPEG format, which uses lossy compression. Some amount of detail may be lost, and the painting may lose transparency if it isn’t completely opaque. To get the highest quality results, use a different method to export your painting.

Copying a Painting

To copy the painting so that you can paste it in another app (for example, Keynote or Mail) tap Copy Image.

Emailing a Painting

To email your painting, tap Mail Image. It will be sent as a standard PNG image.

To access the recorded painting actions, tap Mail Actions and email them to yourself. The attached file can then be opened in Brushes Viewer on a Mac.

Sending a Painting to Flickr

You can send your painting directly to Flickr by tapping Send to Flickr. If you haven’t previously signed in to Flickr, you will be shown a web page where you can sign in. If you’ve signed in before, your painting will automatically be uploaded to Flickr.

NOTE: Once you’ve signed in to Flickr, a new option will appear in the sharing menu: Sign Out of Flickr. Use this if you’d like to switch to a different Flickr account.
Viewing Thumbnails

The default gallery view is great for viewing your paintings up close, but it’s not convenient for navigating when you have a large number of paintings. To get a high level overview of your paintings, tap the thumbnail button:

In the browser that appears, the painting that you are currently viewing will be indicated by a small checkmark. You can quickly navigate to any other painting by tapping its thumbnail.
Painting

When you tap on a painting in the Gallery (or tap the + button to create a new one), the painting will expand to fill the screen and you can begin editing it.

When editing a painting, most of the screen is occupied by the canvas. A navigation bar runs along the top of the screen and a toolbar runs along the bottom. These bars can be turned on and off by tapping once anywhere on the canvas.

To paint, simply touch the canvas and move your finger as though you were finger painting. Each touch becomes a brush stroke.

When you’re done painting, tap the Gallery button in the navigation bar at the top left of the screen to return to the Gallery. Your painting will automatically be saved.
The toolbar at the bottom of the screen provides access to colors, brushes, and so on. Each of these will be explained in more detail throughout the guide.

### Zooming and Panning

To zoom in and out, use the standard iPhone pinch gesture. Touch the screen with two fingers at once—usually the index finger and thumb. Move your fingers closer together to zoom out, and farther apart to zoom in.

Brushes can zoom from 50% to 3200%. While zooming, a zoom level indicator will appear at the top of the screen. When the zoom level gets close to 100%, Brushes will automatically snap to 100%, making it easier to get back to normal.

![600% zoom](image)

You can also “pan”, or scroll, the image while zooming—just move both fingers in the same direction. Once you’ve started a zoom, you can lift one finger to pan without accidentally changing the zoom level.

When painting near the edge of the screen, it can be helpful to pull the canvas away from the screen edge. To do this, just pan, or zoom out.

When the zoom is 100% and the canvas gets close to the edge of the screen, the canvas will automatically snap back, making it easier to get back to normal.
To quickly switch between 100% and your preferred zoom level, double tap on the canvas. If you do not like this behavior, you can disable it by going to the Settings app and turning off the Double Tap Zooming option.

**Undo and Redo**

To undo the most recent change to your painting, simply tap the Undo button. Tap again to undo the change before that, and so on. Similarly, to redo a change, tap the Redo button.

Brushes remembers as many actions as it can fit in memory, so you can usually undo many actions, but you may not be able to undo all the way back to the start of the painting. In practice, this is rarely a problem.
Paint Color

The current paint color is shown in the color well at the left of the toolbar. The color panel can be shown by tapping the color well:

The Color panel uses the hue/saturation/brightness model. To change the hue and saturation of your color, drag the knob within the color wheel. The angle of the knob determines the hue, and the distance from the center determines the saturation. The closer to the center, the less saturated the color.

At the top left of the Color panel are two boxes that display the original color and the current color. The original color is on the left and the current color is on the right. Since the old color and current color are displayed side by side, you can use the old color to help you choose your new color. For example, it's easy to compare changes in darkness, hue, etc.
Transparency is indicated by black and white triangles that are displayed behind the color swatches. The more opaque the color, the less visible the triangles. If you don’t see the triangles at all, then the color is 100% opaque.

On the right side of the color panel is a grid of swatches. When you find a color that you like, you can drag it to the swatch area to save it. You can also drag the swatches around within the grid to rearrange them.

**TIP:** Double tapping a swatch will make it the active paint color and dismiss the Color panel.
Brush Settings

Brushes has only two painting tools, a paintbrush and an eraser. Both tools are located in the center of the toolbar. The active tool is indicated by a light blue background. Tap on the tool that you would like to use to make it active.


To change your brush or eraser settings, tap the brush settings button in the toolbar. This will open the brush panel, where you can choose your brush’s shape, size, spacing, and opacity.
Erasing

The eraser is just like the paintbrush, except it erases instead of drawing a color. When the eraser is the active tool, the brush preview in the brush panel will display a checkerboard pattern.

When erasing, the opacity slider at the bottom of the brush panel controls the strength of the eraser. When it is all the way to the right, the eraser will knock out everything below it. Move the slider to the left to reduce the power of the eraser (for more subtle effects).

TIP: After using the eyedropper to choose a color from the painting, Brushes automatically switches back to the paintbrush.
Simulated Pressure

Brushes can simulate pressure based on the speed with which you move your finger. This can be applied to either the brush size, the paint opacity or both.

When VARY SIZE WITH SPEED is set to ON, the faster you move your finger when painting, the thinner the brush will become. This works especially well with smaller brush sizes where a natural pen-like feeling can be achieved:

When VARY OPACITY WITH SPEED is set to ON, the faster you move your finger when painting, the more transparent the paint color will become:

NOTE: The behavior of the simulated pressure can be inverted. See the App Settings section for more details.
Eyedropper

The eyedropper lets you pick up colors from your painting and paint with them. To use it, tap the eyedropper button in the toolbar. The eyedropper is shown as a colored ring on the canvas. Drag it around the canvas to pick up a color. When you release your finger, the color in the ring is transferred to your brush.

**TIP:** To quickly access the eyedropper while painting, touch the canvas for half a second without moving your finger. After the eyedropper appears, move your finger to pick a color.

The eyedropper tool will not change the opacity of your paint color. When the opacity is low, the eyedropper uses a split display to indicate both the fully opaque color under your finger and the same color with the current opacity:

![Eyedropper Split Display](image)

**TIP:** When you start a painting, choose your palette of colors, and paint a little blob of each one on the canvas. You can then quickly choose colors from your palette by tapping and holding on the blobs.
Blending

You can take advantage of the fact that the eyedropper does not modify your paint opacity to more easily blend between two colors. For example, let's say you've painted two colored regions like this, and you want a smoother blend between them:

1. Set your paint opacity relatively low.

Tap the color well to show the Color panel, set the opacity to something low (around 40%), and dismiss the Color panel by tapping on the canvas.

2. Pick up one of the colors.

Tap and hold over one of the color regions for a moment to bring up the eyedropper and then release to set the paint color:
3. Blend.

To blend, paint over the border between the two regions:

![Blended area](image)

4. Repeat.

Repeat steps 2 and 3, picking up intermediate shades within the blended area, and blending until you get a satisfyingly smooth result:

![Repeated blending](image)
Shortcuts
While painting (if the navigation bar and toolbar are hidden) you can double tap in the corners of the screen to access commonly used features:

<table>
<thead>
<tr>
<th>Top left</th>
<th>Switch between the brush and the eraser</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top right</td>
<td>Change the brush size</td>
</tr>
<tr>
<td>Bottom left</td>
<td>Undo</td>
</tr>
<tr>
<td>Bottom right</td>
<td>Redo</td>
</tr>
</tbody>
</table>

Duplicating a Painting
To duplicate a painting, tap the gear icon in the upper right corner of the screen. In the menu that appears, tap Duplicate.

Painting Properties
Paintings in Brushes have a title, an artist and an orientation. These properties can be edited by tapping the gear icon in the upper right corner of the screen. In the menu that appears, tap Properties.

You can also edit them by tapping the painting title in the center of the navigation bar at the top of the screen.
The title and artist that you set will be visible in the plaque displayed below the painting in the Gallery. The name that you enter for the artist will become the default artist name for future paintings.

If the orientation of your painting does not match the preview image in the Properties panel, you can tap the preview until the orientation looks correct. This will affect the orientation of the image when you email it, add it to your photo album, or upload it to Flickr.
Layers

A painting is made of layers. Think of each layer as a transparent sheet with paint on it. Stack the layers on top of each other, and you see the final painting. Layers that are higher in your painting will obscure lower layers, completely or partially, depending on their contents.

The painting may have up to 6 layers, but only one layer is active at a time. Painting and erasing affects only the active layer.

Layers can be used to separate the elements of your painting. For example, one layer could be used for the background, another for the foreground, and a third for line work. Since you can edit the contents of any layer at any time, you could draw a foreground element first, and later fill in the background by painting in a lower layer.

The layer button, on the right side of the toolbar, shows the state of your layers. Each layer is represented by a box, ordered lowest to highest. Layers that are in use are white, and layers that are unused are gray. The active layer is slightly larger and displays a number indicating its position in the stack of layers.

In the example below, four out of six layers are being used, and the topmost of the four layers is active:

To work with your painting's layers, tap the layer button. The Layers panel will appear:

![Layers panel with four active layers and one active layer highlighted]
The layers of your painting will be spread out across the panel. The leftmost layer is at the bottom of your painting, and the rightmost is at the top. Transparent areas in a layer are indicated by a checkerboard pattern.

The active layer has a blue highlight around it and is slightly larger than the other layers. To make a different layer become active, just tap on it.

- Transform the active layer.
- Flip horizontally.
- Flip vertically.
- Erase the contents of the active layer.
- Duplicate the active layer.
- Add a new layer.
- Merge the active layer with the layer below it.
- Delete the active layer.

The blend mode of the active layer.

Adjust the opacity of the active layer.

TIP: You can quickly dismiss the layers panel by double-tapping a layer.

**Working with Layers**

To rearrange your layers, simply select one and drag it into the position that you would like. You can also change the transparency of the active layer using the opacity slider in the bottom right corner of the layer panel.

To add a new layer, tap the + button on the top right of the panel.

To delete the active layer, tap the trash button. (This button will be disabled if your painting has only one layer.)

To duplicate a layer, tap the duplicate button.

To merge the contents of the active layer with the layer below it, tap the merge button. (This button will be disabled if the bottom layer is active—there is nothing to merge it with.)
To clear the contents of a layer tap the erase contents button.

To flip the contents of the active layer vertically, tap the flip vertically button.

To flip the contents of the active layer horizontally, tap the flip horizontally button.

**Transforming Layers**

To transform the active layer (i.e. move it, rotate it, and scale it) tap the transform button which is at the top left of the layers panel.

When you tap this button the navigation bar and the toolbar will disappear and a message will appear at the top of the screen:

![Message Panel](image)

In this mode, when you drag your finger across the canvas you will move the active layer relative to the other layers. If you pinch your fingers on the canvas you will scale the active layer relative to the other layers. If you place two fingers on the canvas and rotate them, you will rotate the active layer relative to the other layers in the painting.

When you’re done transforming the layer, tap **Accept** in the message panel at the top of the screen to record your changes. If you change your mind, you can tap **Cancel** and the layer will return to its original position and size. After pressing either button, the navigation bar and toolbar will reappear.

**TIP:** When you’ve finished transforming a layer, double tap anywhere on the canvas to accept the changes and get back to painting.
Blending Modes

The blending mode of a layer determines how the colors of that layer interact with the colors of the layers below it.

In the Normal blending mode, the colors do not interact. The contents of the top layer are simply placed over the lower layers. Most of the time, Normal is the right mode to use.

Use the other blending modes for special purposes:

**Multiply**

The colors of the lower layers will get darker, based on the darkness of the Multiplying layer. Use this mode to darken the contents of your painting, or to produce an effect like a highlighter pen.

**Screen**

The colors of the lower layers will get brighter, based on the brightness of the Screening layer. Use this mode to brighten the contents of your painting.

**Overlay**

Overlay is a combination of Multiply and Screen. Bright areas of the layer will brighten the lower layers, and dark areas will darken the lower layers. Use this mode to increase the contrast of your painting.

**Color**

The hue and saturation of the lower layers is set to that of the Coloring layer. This is useful for colorizing a gray painting, or desaturating a colorful painting.

Confused? The best way to learn how to use the different blending modes is simply to experiment. For instance:

1. Start with a layer with very little color, like a black-and-white photo.
2. Add a layer above it, and draw a brush stroke in a bright color.
3. Try the different blending modes on the top layer, and see what effects they produce. How might you use these effects in other situations?
Placing a Photo

You can import a photo by tapping the album button at the top right of the navigation bar:

This will open a panel where you can select the photo that you’d like to import. When you tap a photo thumbnail in the browser, the panel will disappear and you will be able to position, scale and rotate the photo however you’d like (this works exactly like layer transforming).
When you’re done positioning your photo, tap Accept or double tap anywhere on the canvas. If you decide not to import the photo, tap Cancel.

When you place a photo, a new layer is created for it at the top of the layer stack.

**NOTE:** If you already have 6 layers in use, you will not be able to import a photo. The album button will be disabled.
App Settings

Brushes has a handful of preferences that can be found in the built-in Settings app on your iPad. To view them, open the Settings app and find **Brushes** in the list of Apps on the left:

![Settings App](image)

**Double Tap Zooming**

When this setting is **ON**, you can double tap anywhere on the canvas to zoom in and out.

**Automatically Hide Toolbars**

When this setting is **ON**, the navigation bar and toolbar will automatically be hidden when you start painting. When **OFF**, they remain visible unless you explicitly tap the canvas to hide them.

**Inverted Pressure**

This setting reverses the behavior of the speed-based simulated pressure.

Normally, when VARY SIZE WITH SPEED is **ON**, the brush becomes thinner as you move faster. When **Inverted Pressure** is **ON**, the brush becomes thicker as you move faster.

Similarly, when VARY OPACITY WITH SPEED is **ON**, the paint becomes more transparent as you move your finger faster. When **Inverted Pressure** is **ON**, the paint becomes more opaque as you move faster.
External Displays (TV and VGA)

Want to see your painting on the big screen? Or show off to a whole classroom?

Brushes will automatically use an external display, like a TV or projector or computer monitor, which is attached to your iPad via Apple's Dock Connector to VGA Adapter or Component AV Cable or Composite AV Cable.

Simply plug in your display, and Brushes will find it.

On the iPad itself, everything works just like normal. In addition, the external display shows:

- Paintings in the Gallery, including stroke-by-stroke playback
- The live painting, as you paint
- Changes to the current color
- Changes to the brush settings
- Changes between brush and eraser
- Changes in layer position and size
Brushes Viewer

Brushes Viewer is an application for Mac OS X that allows you to open the .brushes files that are created by Brushes. See the Emailing a Painting section to learn how to transfer the .brushes files from your iPad to your Mac.

Brushes Viewer will run on Mac OS X 10.5 (Leopard) and higher, on both PowerPC and Intel-based Macs. To download the latest version of Brushes Viewer, go to:

http://brushesapp.com/viewer

Opening .brushes Files

To open a .brushes file, double-click on it in the Finder or drop it on the Brushes Viewer application icon. Brushes Viewer will open the painting in a new window. The viewer generates a preview of the painting from the data in the .brushes file. You can drag the preview image out of the window and drop it on another app.
Replaying the Painting

The painting window displays several controls for replaying the painting.

Play. Click here to start playing the painting. During replay this button switches to Pause.

Advance one frame. When the painting is paused (and not at the end) this will display the next stroke in the painting.

Advance to the final frame.

Replay speed.

While the painting is playing, a small triangle will move along the bottom of the preview image to indicate the progress.

Rotating

If your painting should be in the “landscape” orientation—that is, wider than it is tall—simply tap the Rotate Left or Rotate Right buttons in the toolbar, or use the menu items in the Tools menu.
Exporting an Image

Brushes Viewer can generate images with up to 6x the resolution of native iPad paintings (4608 x 6144). To export an image at a higher resolution, click on the Export Image button in the toolbar or choose File > Export Image…

This sheet will let you choose the export options:

Choose the export size, image format, and image quality, then click Next…

**NOTE:** Quality is applicable only for the JPEG format, since it uses lossy compression.

Choose a filename in the save panel, and click Save. While the image is being exported you will see a sheet indicating the progress.

**NOTE:** Exporting at high resolution, or exporting paintings with many strokes, may take some time.
Exporting a Movie

Brushes Viewer can also generate movies from your painting. Each stroke in your painting becomes a frame in the movie. To export a movie, click on the Export Movie button in the toolbar or choose File > Export Movie…

This sheet will let you choose the export options:

You can export movies at up to 3x the resolution of a native iPad painting (2304 x 3072). Choose the export size, compression type, quality, and frame rate, then click Next…

Choose a filename in the save panel, and click Save. While the movie is being exported you will see a sheet indicating the progress.

NOTE: If your painting has many strokes, exporting a movie may take some time, and the resulting file may be quite large (depending on the settings).